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About Adagio Accounting 
Adagio by Softrak is a powerful, modular, batch-oriented accounting system. Adagio offers full departmental 
accounting that is easy to learn, with form and keyboard-oriented data entry, tight audit trails and unsurpassed 
flexibility with reports. 

 

About Adagio BankRec 
The Adagio BankRec program provides you with an easy way to track your bank account balances. Adagio BankRec 
provides a centralized module to manage your cash position. Find out your current bank balances with a single 
mouse click. Pick up transactions from Adagio Payables and send cash receipts to Adagio Receivables. Account for 
NSF checks in a single step. Reconcile all your accounts to your bank statement and Adagio Ledger in minutes 
instead of hours. 

 

About this courseware 
This courseware is designed to serve multiple functions.  It is designed to be used in conjunction with the 
documentation provided with the software.  While you can use this training manual to learn the fundamentals of 
Adagio Ledger, you can also use it as a reference tool in your everyday work with this module.  Since this training 
manual is focused on the day to day operation of Adagio Ledger, data files have been provided for you representing a 
company for which the accounting system has already been set up.   

While this courseware is thorough, it is not encyclopedic and comprehensive.  It does not describe the tasks that 
should only be performed by an authorized Adagio Accounting service provider.  These services are usually 
provided by your regular accounting software consultant.  For example, if you have an Adagio Consultant Reseller 
(ACR), your ACR will be able to provide the necessary services to setting up your Adagio Ledger system.  While 
this manual does provide you with all of the information you need to become an efficient and successful user of 
Adagio Ledger, it cannot answer every potential question you might have.  However, it will instruct you in the 
module's concepts and functions so that you can adapt to new challenges as they arise. 

While using this courseware, you can press F1 for context sensitive help in the function you are currently in.  Full 
product manuals are available online at http://softrak.com/products/documentation.php. 

The courseware includes references to ‘Show me how” videos provided by Softrak Systems Inc. with references to 
videos indicated by the        icon.  

Training data that accompanies the Using Adagio series of training guides can be downloaded from 
www.lng.bc.ca/downloads.  

 

Prerequisite Skills 
This courseware assumes that you have a working knowledge of the Windows operating system and its conventions.  
This knowledge includes how to use the mouse, menus, dialog boxes and how to work with files.  For assistance 
with questions pertaining to the operating system, you should refer to your Windows documentation. 

 
How to Submit Comments and Suggestions 
At LNG Management Services Ltd., the primary purpose of our courseware is to increase your productivity in the 
workplace.  In order to meet this goal, we constantly review our work to ensure that we produce the best courseware 
possible. 
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If you have any comments or suggestions, please contact as by sending an email to comments@lng.bc.ca. 

For additional information on our available training courseware and training sessions, please visit our website at 
www.lng.bc.ca.  

 

        Introduction to Adagio - https://www.youtube.com/watch?v=IF_M9k1kONs 

       

        What’s new in Adagio BankRec 9.2A - https://www.youtube.com/watch?v=GBsRd64H3P4 
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Part I 
Part I consists of lessons 1 to 7 that are designed to provide an understanding of the BankRec program and the skills 
to implement BankRec.  This part should only be completed by those who are designated to manage the BankRec 
program.  If you are responsible for the daily and periodic tasks in BankRec, please refer to Part II, page 41. 

To complete this part of the courseware, download the training data from 
http://lng.bc.ca/datasets/EWINewStartData9.2.ZIP 

 

Objectives: 
After completing Part I, you will be able to: 

 understand the data flow between BankRec and its related modules 

 be aware of the primary functions 

 start BankRec 

 open existing datasets 

 modify user preferences 

 review company profile options 

 create and modify banks 

 create and apply bank reconciliation rules 

 set up banks 

 prepare BankRec for daily and periodic tasks 

 create template for importing electronic bank statements 
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Lesson 1 - Adagio BankRec Overview 
The following diagram provides an overview of the dataflow between Adagio BankRec and other programs. 

 

 

     

 

 

 

 

 

 

 

 

Adagio BankRec’s central purpose is to manage the bank accounts for your company.  

The following table describes the primary functions performed in Adagio BankRec: 

Creating Batches    Number of batches can be created in BankRec including batches that have been: 

• Created by entering deposits, checks and bank charges 
• Created by retrieving checks entered and posted in Payables 
• Created during a bank reconciliation 
• Imported from non-Adagio programs 

Bank Reconciliation You can reconcile transactions to a bank statement by manually reconciling each 
transaction or a range of transactions. You can also reconcile transactions by 
importing your bank statement and electronically reconciling the statement with items 
in the outstanding item list. 

Reconciling NSF 
checks 

If you have posted NSF checks, these checks will appear along with any related bank 
and customer service charges.  

Posting Batches This process updates the transactions in each of the bank accounts. The process also 
creates a batch retrieved to Receivables to apply receipts from customers to their 
account. Payments to vendors can also be entered to apply payments in the vendor’s 
account in Payables 

Note: BankRec does not provide the ability to print checks. If you are using system 
generated checks, these must be entered in the Payables module. 

Reports There are several useful reports in BankRec including cash flow analysis and deposit 
slips. Other reports include Bank reconciliations and transactions. 

 Payables 

 

                          BankRec 

 Retrieve batches 

Sub-ledger batch  

Payroll 

 

               Receivables 

 

 

               Ledger 

 

Management 
Reports 

Import batches 

Retrieve batches 

Create batches 

Create batches 

FOR P
REVIE

W
 O

NLY



 

6 | P a g e   Using Adagio BankRec 

Period End Processing Period end processing will purge reconciliation information from your database. You 
can select specific banks, a range of banks or purge all reconciliation information 
before a specified date. 

Year End  Processing Year-end processing works in much the same manner as period end processing.  
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Lesson 2 - Getting Started 
The Adagio Accounting system is a modular accounting system. This means that each of the modules, including the 
BankRec, needs to be started individually. It is also possible to run several companies using each module. For 
example, you may have Company A and Company B in your organization where each Company has its own dataset.  

Once you have started Adagio, the following window appears: 

 

Enter the User ID and Password provided to you by the system administrator.  

Select the date that you want to use as a default for journal entries. The month of this date will determine the current 
period that you want to work in. It will also be the default date of the transactions you enter. 

The data path and extension will default to the last opened dataset. To open a dataset in a different location, you 
can either use the file finder or previously opened file finder. The Previously Opened finder will list all of the 
datasets that have previously been opened. When using the file finder, the following window will appear: 

 

Using your mouse pointer, navigate to the location of the dataset that you want to open. Then double click on the 
GLGLOB file that appears under the Files section. 

If the GLGLOB file does not appear in the Files section, you have either pointed to an incorrect location, or the 
BankRec files have not been created. 
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When using the Previously Opened files finder a window similar to the following will appear: 

 

Select the desired Company Name and press the Open button. 

To remove an entry from this window, select the Company Name you want removed. Click the Right mouse button 
and select Remove. This simply removes the entry from the previously opened window – it does not remove the 
dataset from your computer. 

 

Exercise 2.1 
Electronics World Inc. is the sample company that will be used to demonstrate the functions of Adagio BankRec 
through a series of exercises. Electronics World Inc. is an expanding chain of retail computer stores and is in the 
process of implementing Adagio. The installation and implementation of Adagio has been completed by the 
company’s Adagio consultant who has created the dataset and entered basic information to get the company started 
using the Adagio BankRec module. The date is May 31, 2014. 

Start the Adagio BankRec by double clicking on the shortcut located on your Desktop. If there is no shortcut, you 
can open the Adagio Receivables from Start, Adagio, and Adagio BankRec. 

Enter May 31, 2014 as the session date. Enter the date in the format used by your Windows operating system. You 
can also use the Calendar button to select the date from the calendar. 

Enter the path to your dataset as C:\Softrak\Trngdata and the data extension as EWI. 

When the information has been entered in the login window, click the OK button. 

Note: Since the Adagio BankRec has been implemented prior to completing the Payables exercises in the previous 
training sessions, you will be notified by the program that there is an outstanding Payables to be retrieved. For the 
purpose of this course, it is important to answer “No” to retrieve the batch from Payables so that exercises can be 
completed in this module. 

You are now ready to proceed with the exercises contained in this courseware. 
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Lesson 3 - Understanding ADAGIO BankRec Options 
It is important for the user to understand the options and setup of each Adagio module.  

User Preferences 
From the File menu, select User Preferences. 

 

General  
By Application 
The first panel provides options that control the appearance of Adagio BankRec's Menu, Toolbar and Status bar.  For 
example, if you want to fax or email payment advices to vendors, you must first include these items in the menu bar.  
You can also select the options that control the appearance of the Toolbar. 

If you are resizing and repositioning entry forms, e.g. Invoice entry form, you can select the options to Save window 
position and Save window size.  When these options are selected, the size and position of these windows will be 
saved and will open to how they were set in the last session next time BankRec is opened. 

You can also select the option to Auto-advance smart finder that will advance to the next item displayed in the 
Smart Finder listing after the first item has been selected for editing.  This is useful if you are reviewing or editing 
vendors that meet a certain criteria where you do not have to redo the Smart Finder each time you have finished 
reviewing or editing a particular vendor. 

Select Implied decimal if you want the program to automatically place the decimal in an amount the number of 
spaces from the left depending in the currency's number of decimal places.  When this option is selected, it will 
affect all modules company-wide. 
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When selecting Alphabetically sorted field list you will be able to sort the field lists within Grid Filters Edit and 
the Column Editor.  This is useful for field lists that are lengthy from which you want to find the desired field 
quickly. 

In the Grids and Finders section, you can override the applied filter styles for records seen in grids and 
Finder/SmartFinder windows and apply your own style of banding instead.  On windows that display the Filters 
dropdown, the true filter styles will continue to display in the Filters dropdown. 

• Ignore style properties – enable this option if you want to override the styles applied to BankRec records 
by filters with your own style. 

• Color every [] rows – this field is only active if Ignore style properties is enabled.  Enter the number of 
rows you want to apply your style to.  For example, if 5 is entered, your style background will be applied to 
records 1-5, 11-15, 21-25, etc.  Records 6-10, 16-20, 26-30, etc. will have no style applied to them at all. 

• Row Backg – use this field to select the color you want to apply as the Row Background for records 
affected by your Color every [] rows selection.  Select an existing color in the palette or Define a Custom 
Color and Add it to the Custom Colors palette. 

The next section allows you to select options for emailing and faxing, and how the data entry forms will behave.  
Selecting Auto add entry will allow you to add line items in the details form without having to return to the header 
each time a line item is entered.  This is particularly useful if you enter invoices with more than one detail line on a 
regular basis.  When Remember batch entry fields is selected, the program will keep the entry in the header fields 
each time a new document is entered.  Once you have exited the data entry function, the data in the header fields will 
be reset. 

  
By Company 
On start-up . . .  

The next panel provides you with the options as to which window(s) you want opened automatically when launching 
the program.  You can select as many as you require.  When opening multiple windows, it is a good idea to resize 
and reposition each of the windows to make your desktop manageable.  Otherwise, the windows will be stacked on 
top of each other. 

If you are importing transactions, using the program's Import function, you can have the program automatically 
process the import of Vendors, Invoices or Checks.  If you are using this option, you must enable the Auto-import 
on startup option in the import template.  

Adagio toolbar 

You can select the installed Adagio programs to appear in the toolbar as a quick access to the sub-ledger modules 
from within the open module. 
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Appearance 

  
This panel allows you to set a background color.  You can also include an image or text to appear in the main 
window of BankRec.  Using the path field, navigate to the location of your graphic that you want to use as a 
background image.  When including an image in the background, you can format the appearance of the image.  
Under Display Options, you can stretch the image or center the image on your Adagio desktop.  The options 
available in this window relate only to the company that is currently open.  
 

Report Options 
Select the Report Options tab to select the various options that affect the printing and previewing of the Payables 
reports. 
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The options included in the first panel of this window affect the specific company and control the appearance of the 
reports.  When Remember report settings? is selected, the program will remember the parameters of the specific 
report being previewed or printed.  The ranges can be excluded from being 'remembered' by selecting the Exclude 
ranges option. 

Once the requested report has been printed, select the Close report dialog after print?.  This automatically closes 
the report dialog window.  If additional reports are required, use the Reports from the task bar, or Post | Batch 
Posting Journal menu to print either management reports or posting journals. 

The date and time format options provide you with options in how the date and time are to be indicated in the 
reports. 

There are also options on how to display the report when previewing and what elements are included in the printed 
report, e.g., showing the print parameters on all pages, showing the footer, shading headers, footers and subtotals, 
and the color to be used if shading is selected. 

The Default print to file format and Default print to file path allows you to set the file type, e.g., Excel, HTML or 
Word format when printing the reports using the Destination Options when printing the report to a file.   

If you are using Adagio ePrint, you can set the default PDF print Options that will affect the specific user. 

When you Enable the PDF Print, the other options will become active and both the EP       and EP Options                
will appear in the report print window.  Use the EP button to print to PDF using Adagio ePrint and the regular Print 
button to print to another printer. 

If the same option has not been enabled with the Company Profile, not of the PDF Printing options will be active. 

Select the Open PDF document if you want to automatically opening the PDF document after it is printed. 

When Paperless reports option is selected, the Print button in all report print windows will change to an EP Print 
                 button. 

The Open folder option will automatically open Windows Explorer which will allow you to assign a different file 
name and/or save it to a different folder. 

Enable the Enable Email PDF option which allows you to email documents created using the Adagio ePrint.  When 
enabled, an Email        button appears on the report print windows.  Email options may be changed for a particular 
report using the EP Options button in the print windows.  This button does not appear on form (specifications) print 
windows as emailing of specifications already has its own Email button. 

When the using the option to email reports, you can also enter default email addresses in the Default recipient field 
and to Compress PDF on send.  

Finally, when logged in as SYS, all of the users' preferences can be reset to those selected by the Adagio System 
administrator by clicking on the Set All Users button.   

However, if the individual users have access to the User Preferences, they will be able to change these options to 
suite their own preferences 
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Lesson 4 - Company Profile 
The company profile contains information about your company that is used throughout Adagio BankRec. Generally, 
you only need to enter this information once unless changes occur in your company. 

Select Edit | Company Profile from the menu. You can also select Profile from the Toolbar bar. 

Profile 

 

The information contained in this section is basic company information including Company Name, Address, 
Telephone number, Fax number, Contact, etc. If the company will be multicurrency, this is selected in this section.  

Once the Multicurrency has been checked, you cannot change the setting once the data has been saved. Data is 
saved when you close the Company Profile window by clicking on the OK button.  
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Interfaces 

 

This section allows you to set various preferences as to how you want the program to integrate with other modules. 
Default account numbers for bank transactions are also set up in this window. 

The Ledger Options panel allows you to select and edit various options and fields that relate to posted transactions.  

When Consolidate bank transactions? is checked the posted transactions will be consolidated when retrieved to the 
Ledger. 

Uncheck the Prompt to consolidate? to prevent consolidation of transactions after printing the G/L transactions 
report. 

You can specify the information being sent to the General Ledger where the BankRec entries are retrieved. 

When the Include batch info is desc. 1 option is enable, the Posting references including batch and entry number 
are prefixed to the information selected in G/L Description 1.  If you only want the information as specified for G/L 
Description 1, do not enable this option. 

Send to G/L Reference, G/L Description 1 and G/L Description 2 can be determined by selecting the appropriate 
options from the drop-down menu.  The Reference and G/L Description 1 information is found in the entry header 
window, while Description 2 is the description found in the detail line of the entry.  Click on the Help button to find 
the parameters to be used when selecting the User defined option. 

The Receivables options control how the transactions are to be handled when integrating with the Adagio 
Receivables module. 

Posting mode determines how the batch posted in BankRec will be created in Receivables module.  The options are 
to Create retrieval files where the BankRec transactions need to be retrieved into the Receivables using the 
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Retrieve function under the Maintenance menu. or Directly create batches where the batch is automatically 
created in the Receivables when the posting in BankRec is completed.  There is no retrieval of batches necessary 
when this option is selected. 

Send to Description determines what information is retrieved in Receivables after posting the transaction in 
BankRec. 

Autopay by allow you to control how the Autopay function works.  This function can automatically apply payments 
to several invoices based on the total payment you enter. Autopay can rank the invoices in two different ways. If you 
want Autopay to select invoices with the earliest due date first, then select Due date. Or, select Transaction date to 
have autopay pay the invoices in order according to their transaction date. 

Autopay use credits option indicates whether or not you want Autopay to use credits when automatically applying 
payments, and in what order.  The options include 

• Never 
• Cash first 
• Credit first 

Show All Transactions should be selected if you want to see all transactions that have been reconciled.  As this is a 
default setting, you can hide the reconciled transactions from the View Transactions window. 

Warn if customer on hold in entry? - In Adagio Receivables, you can put a customer 'on hold'. You may do this if 
they have exceeded their credit limit. For example, when you're working in Adagio BankRec, perhaps entering 
receipts from a customer who's been put on hold, you can receive a warning about their hold status by turning this 
option on. 

When this option is turned on, you are also given the ability to remove the hold from the customer file after a receipt 
has been entered.  
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Options 

 

This section provides default information regarding your banks and transactions including NSF checks. It also allows 
you to select various options as to how you want the program to behave.  

Default bank - Select the bank that you use most frequently in BankRec. When you create a new batch, this will 
automatically be selected as the bank for the new batch. It’s intended to save you time, but of course you can change 
the bank for each batch you create. 

Days to keep history for - The number of days you decide to keep period end historical data regarding fully paid 
transactions can be changed at any time. 

You may want to set this number high so that you retain a long history of transactions. When questions regarding 
specific transactions arise, you will be able to view the history and solve problems to help you and your vendors. 
While this data may not be used for many months, it can be valuable when questions arise about past transactions 
which are not easily remembered. The default value for this field is 365. 

Use bank NSF G/ L Acct - Turn this option 'on' to have NSF fees charged distributed to the Service Charge GL 
account specified within the Bank record.  Leave this option turned 'off' to have NSF fees charged to the NSF G/L 
Account specified within the Company Profile. 

NSF Customer charge - Enter the amount you typically charge customers for NSF checks. 

NSF G/L Account - Specify a default G/L account for NSF charges. This is the account that will be used by default 
when you create new banks, and if you did not already choose to use the bank’s NSF G/L account for NSF charges. 

Purchase discount G/L - G/ L Select the general ledger account to use for purchase discounts. 
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Check for duplicates - If you elect to check for duplicates, Adagio BankRec will create an error batch when you try 
and post any transactions containing duplicate check/reference numbers. Otherwise, Adagio BankRec will allow you 
to post these. 

Allow edit of retrieved batches? - If this option is turned on, you are able to edit transactions that have been 
retrieved from other modules. Normally, this option should be left off, since editing retrieved batches may cause 
inconsistencies in your data. 

Tax tracking - Turn this option on if you report on tax information. Adagio BankRec distributes purchase and tax 
amounts to the general ledger by way of distribution codes. When you post a purchase or tax amount you select a 
distribution code that has been linked to a general ledger account. This allows the transaction amount to be 
distributed to the general ledger for reporting on the trial balance and on financial statements. 

Allow print receipts - Turn this option on if you wish to be able to print receipts. If you turn this option on, an 
additional tab will appear in the Company Profile, the Receipts tab, where you can set up your receipt defaults. 

Auto-backup after DIC? - Turn this option on to ensure Adagio Receivables automatically performs a backup of 
Receivables data immediately after Data Integrity Check completes.  If integrity is clean, it appends _Clean to the 
end of the backup file name.  In the event Data Integrity Check finds errors and presents the Rebuild button, a 
backup is performed prior to rebuilding errors in DIC.  The backup will have _Prebuild appended to the zip file 
name. 

Auto-post after retrieve A/R? - Turn this option on if you want batches retrieved from Adagio Receivables to 
automatically post after they are retrieved into Adagio BankRec. 

Existing batches that have retrieved transactions appended to them will be posted also. 

Auto-post after retrieve A/P? - Turn this option on if you want batches retrieved from Payables to automatically 
post after they are retrieved into Adagio BankRec. 

Auto-post after retrieve PR? - Turn this option on if you want batches retrieved from third-party Payroll programs 
to automatically post after they are retrieved into Adagio BankRec. 

Batch Options  

This panel allows you to determine the default information that will be included when creating batches in BankRec. 

Batch description - Use this field to enter a default description for each new batch created. You may also use three 
BankRec variables that will automatically enter specific information in the description. 

Enter %usr to automatically include the Adagio UserID of the person who creates the batch. 

Enter %dat to automatically include the system date the batch was created. 

Enter %tim to automatically include the system time the batch was created. 

This affects batches created by BankRec only and not batches retrieved from other applications or imported. 

Batch description date format - Select one of the following formats for the %dat variable to use in the Batch 
description: 

Windows short - from Windows Regional settings 

Windows long - from Windows Regional settings 

Rpt. options (Hdr) - as specified in Reports | Report Options 

Rpt. options (Det) - as specified in Reports | Report Options. 
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Batch description time format - Select to use either a 12-hour or 24-hour time format for the %tim variable to use 
in the Batch description. 

The bottom of the Options tab displays some information that may be of use to you from time to time. It shows the 
Next batch number, the Next posting sequence, and the dates for the Last period end and the Last year end. 

Reports 

 

This Report Options control how reports are printed or displayed when using ePrint.  

Posting Journal G/L Distributions summarized by - When you post your bank reconciliations to the G/L, you can 
choose how the G/L distributions are summarized. You can have them summarized by Account/Dept. or by 
Distribution/Account/Dept. 

Force listing of batches - If this option is turned on, the software will insist that a batch listing be printed before it 
will allow the batch to be posted. If you regularly check batch listings against original documents, it may be 
beneficial to turn this option on. 

Force listing of retrieved batches - Similar to the above option, but this option pertains to batches that have been 
retrieved from Adagio Payables. If you are certain that batch listings are printed and checked for accuracy from 
Adagio Payables prior to retrieval into BankRec, you may wish to leave this option turned off. 

Auto print posting journal after post? - If you have this option turned on, the software will automatically open the 
Print Posting Journal dialog directly after a batch has been posted. This serves as a good reminder to print a posting 
journal each time you post batches. 
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Even if this option is turned on, you can still elect not to print a posting journal by clicking on the Close button on 
the Print Posting Journal window when it appears. 

Receipts Options 

If you haven't turned on the "Allow print receipts" option in the Options tab of the Company Profile this tab will not 
contain options for setting your print receipt preferences. 

Receipt # prefix  - If you want your auto-generated receipt numbers to have a prefix, enter that prefix here. Your 
prefix can be up to three characters long and can contain any alphanumeric characters. 

Next receipt # - Enter the receipt number you wish to start with. After you click OK to save your receipt options, the 
receipt numbers will be auto-generated starting from this number. This number will increase by one each time a new 
receipt is issued. 

Mark faxed receipts as printed - If you will be using the faxing option at times, in place of printing and mailing a 
receipt, and you want to ensure that faxed receipts are treated as having been printed, turn this option on. 

Mark emailed receipts as printed - If you will be using the emailing option at times, in place of printing and 
mailing a receipt, and you want to ensure that emailed receipts are treated as having been printed, turn this option on. 

Print receipts by default - When you're entering receipts, the batch entry window will have an option to Print 
Receipt. If you generally will want to print receipts whenever possible, you can enable this option in the Company 
Profile to ensure that in the batch entry window the Print Receipt checkbox will be enabled by default. If you don't 
usually print receipts, leave this option disabled. In either case, this is a default only and can be changed for each 
receipt that is generated. 

Adagio Receivables has its own options for whether receipts should be printed by default for all or specific 
customers only when receipts are retrieved to BankRec.  Therefore, the Company Profile option within BankRec has 
no effect on whether or not the option is enabled or not for receipts retrieved from Adagio Receivables into BankRec. 

When Adagio ePrint is installed and the Allow PDF print? option is selected, additional options pertaining to the 
ePrint PDF feature become available within ePrint enabled modules.  Most of the same options are available in each 
module.  

Force paperless reports? Enable this option to force all report printing to be directed to the AdagioPDF 
printer.  The standard Print button on print report windows will become an                button, regardless of whether a 
user has activated PDF printing within their own User Preferences. 

If this option is disabled and both the Allow PDF print? Company Profile option and the similar function within a 
user's User Preferences are enabled, a user having access to Edit PDF Setup may still enable Paperless reports 
within their own User Preferences. 

If Lock PDF setup is enabled and the Force paperless reports? option is also turned on, all printed reports for all 
users will use the AdagioPDF printer only.   

If Lock PDF setup is disabled and the Force paperless reports? option is turned off, users who have turned on their 
Enable PDF print option in their User Preferences, will still be able to print to the AdagioPDF printer using the EP 
button on print windows.  As well, they will still be able to enable their own Paperless reports option within their 
User Preferences.  All users will be able to print to available printers using the Print button that is standard within 
Adagio modules. 

Additionally, the default PDF reports folders as originally set in the Company Profile will be the paths used 
whenever users print to Adagio ePrint (eg., if                is selected on a report print window or if the AdagioPDF 
Printer is selected from the Setup button, the Folder path can’t be edited). 

Report Sets, if available within a module, are independent of this option. 
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Allow PDF email enables the option of emailing AdagioPDF files created within this Adagio module from a print 
window.  To be used, the option must also be enabled within a user's User Preferences. 

PDF document folders for (Embed codes like %usr, %sdt, %dat, %tim) 

For each type of report, a default path off the base level path is specified for the reports of that type to be saved 
to.  You may edit this path. 

You may choose to embed codes such as %usr (user ID), %sdt (session date), %dat (system date) and %tim 
(system time) into the folder.  For Forms, you can also use the %frm (form/specification type, eg. in Receivables - 
statement or letter).  For example, you might embed %usr and %sdt in a folder name and later, when you perform the 
pdf print, embed %dat %tim within the filename using the                  button.  Forms filenames are predefined by the 
program.  %sym will return the session year and month, while %dym returns the system year and month.  These 
variables might be particularly useful to identify posting journals and such that have been printed for a particular 
fiscal year and period.  

If PDF report paths are changed later, the default folders that users print to will not automatically change to the new 
Company Profile settings.  In order for this to occur, the Restore button must be used within the users' User 
Preferences.  Or, if logged in as the Adagio System Administrator SYS, the defaults may be restored for all users all 
at once using the Restore button. 

Other report options that are Adagio user specific may be found within User Preferences. 
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Exercise 4.1 
In the Company Data tab, change the Contact name to your own name.  

Select Consolidate bank transactions.  Deselect the option to Include batch info in desc. 1 to exclude posting and 
batch information as part of the Description line 1.  From the Interface tab, select Directly create batches as the 
posting method for transferring batches to the Receivables module. 

In the Options tab, use the Golden Bank as the Default bank.  Change the number of days to keep history to 90 days.  
Select the options to automatically post transactions retrieved to the Ledger for Receivables and Payables. 

In the Reports tab, ensure that the Auto print posting journal after post? is selected to ensure posting journals are 
consistently printed after posting.  The Allow PDF print? and Force paperless reports? options should be selected 
as all reports generated in BankRec will be generated as PDF documents.  The paths for saving the various PDF 
documents can remain as shown.  In the File conflict strategy panel, select the Append option in order to append 
documents to the end of an existing document with the same filename. 
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Lesson 5 - Preparing to Use BankRec 
In most cases, BankRec is implemented after all the other financial modules have been installed and used for a 
period of time. Therefore, there are some important steps to take in order to synchronize the banks in BankRec with 
the bank balance in the general ledger and on the latest bank statement.  

Gather banking 
information required for 
the Company Profile 

 

This information includes integration and account information. 

 

 

Gather bank information 
required for the Bank 
setup 

 

This information includes that information relating to the bank account(s) for which 
BankRec will be used. This includes bank accounts, line of credit and credit cards. 

 

Obtain the most recent 
bank statement and 
manual reconciliation 

 

This information will be used to complete the Bank set up. The bank statement date and 
balance cannot be changed once the Bank record has been saved. 

 

Prepare a list of 
outstanding checks and 
deposits 

 

The list of outstanding items must be the same as the outstanding checks and deposits on 
the bank reconciliation prepared prior to implementing Bank Rec. 

 

Enter outstanding checks 
and deposits in a batch 

 

The outstanding items are those that are shown as outstanding in the bank reconciliation 
prepared prior to implementing BankRec. 

 

Post batch containing 
outstanding items 

 

Once the outstanding checks and deposits have been posted, the BankRec should be 
balanced to the bank reconciliation prepared prior to implementing BankRec. 

 

Retrieve to Ledger and 
sub-ledgers. 

Once you have retrieved the BankRec batches to the Ledger, Payables and Receivables, 
they need to be deleted to avoid duplication of entries in the Ledger and sub-ledgers. 
The checks and deposits that are outstanding as of the cut-off date, have already been 
included in the accounts at the time of original entry. 
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Appendix C – Index 
 

Adagio Receivables, 25, 59 

Adagio toolbar, 10 

Auto Matching, 55 

Auto-advance smart finder, 9 

Auto-import on startup, 10 

Autopay, 15 

Banks, 24, 31, 32, 38, 40, 53, 58, 64 

Cash flow analysis, 6 

Company profile, 3, 13, 25 

Dataflow, 5 

Default bank, 16, 21 

Deposits, 46 

Electronic bank reconciliation, 38, 54 

Electronic bank statements, 3, 32, 38 

Electronic reconciliation, 31, 38 

Entering deposits, 5, 45 

Filter, 10, 35 

Implied decimal, 10 

Import Bank Statements, 40 

Integration, 14, 25 

Keyboard shortcuts, I 

Manual matching, 55 

Manual Reconciliation, 53 

Menu, 9 

Notes, 30 

NSF charges, 16 

NSF checks, 1, 5, 16, 43, 58, 59 

NSF fees, 16, 24 

Payables, 1, 5, 8, 11, 17, 18, 21, 23, 25, 31, 43, 45, 48, 
51, 52, 62, 64 

Payments, 5, 45, 48 

PDF print, 12, 19, 21 

Period End, 6, 64, 65 

Period end processing, 6, 64 

Print receipts, 17, 19 

Receivables, 20, 21, 23, 25, 28, 31, 45, 47, 60, 62, 64 

Reconcile transactions, 5 

Remember report settings, 12 

Report options, 11, 17, 18 

Report Options, 11 

Reports, 6, 12, 17, 18, 21, 61, 62 

Retrieving checks, 5 

Retrieving transactions, 51 

Reversing checks, 57 

Save window position, 9 

Save window size, 9 

Show all transactions, 15 

Smart Finder, 9, 35, II 

Statement rules, 26, 34 

Statement Rules, 34, 35 

Status bar, 9 

Toolbar, 9, 13, 53 

Transactions, 47 

Transferring funds, 32, 50 

User preferences, 9, 12, 19, 20, 35 

Year End, 6, 65 
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